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BD34-3 A picture really is worth a th ousand words. Great pictures are worth even more. Superb photorealistic visualizations are 
within your grasp with VIZ Render, which is included in Autodesk® Architectural Desktop. Learn to use your 
Architectural Desktop models to convey the feeling of a space to clients in a medium they can understand. 

 Who Should Attend 
Architects, building engineers, CAD managers, contractors 
 
Topics Covered: 

o Setting up the scene 
o Using procedural maps for materials 
o How to work with exterior daylight and radiosity 
o Learn to mix quality and speed for rendering and radiosity settings 
o Adding entourage to your scenes using vendor content  

 

 

About the Speakers: 
Jim pursued study abroad with the University of Kentucky's Atelier Veneziano. He is a registered Architect 
(AR0017182) and an active member of the AIA. He has held instructional positions at Jacksonville University and 
Florida Community College at Jacksonville. Jim has successfully trained over 500 professionals and students in 
Autodesk® VIZ, Autodesk® Architectural Desktop, and AutoCAD®. Prior to training as an Autodesk Certified 
Instructor, Jim worked in Architectural firms in Kentucky and Florida where he performed the duties of CAD manager 
and project manager. Jim is currently a part of the Quality Assurance team at Autodesk, responsible for delivering 
Architectural Desktop. Jim has also teamed up with Paul F Aubin to author Mastering VIZ Render for Autodesk ADT 
Users. 

Paul is the author of several books on Autodesk® Architectural Desktop including Mastering Autodesk® Architectural 
Desktop, and the newly published Mastering VIZ Render: a Resource for Autodesk ADT Users coauthored with 
James D. Smell. Paul is an independent consultant offering training and implementation services to architectural firms. 
He also serves as the moderator for CADalyst magazine's online CAD Questions Forum and has spoken at AU for 
many years. The combination of his experiences in architectural practice, as a CAD manager, and an instructor gives 
his writing and instruction a fresh and credible focus. 

You can reach either of the speakers at MasterVIZr@paulaubin.com 
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Introduction 
VIZ Render is a stand-alone rendering and animation package bundled with the latest releases of Autodesk 
Architectural Desktop. It shares much of its interface in common with its siblings Autodesk VIZ and 3dsmax, but 
has a much more limited feature set than these applications. It is a feature of Architectural Desktop and as such, 
all modeling (and much material application) is accomplished in Autodesk Architectural Desktop (ADT). VIZ 
Render (VIZr) is then used to fine tune the material application, add lights and cameras, and generate high 
quality renderings and animations. The goal of this class and this paper is to demonstrate to both novice and 
experienced 3D artists the process and capabilities of the ADT/VIZr tool set. We also hope to prove that a picture 
worth a thousand words really can be created with the product you already own; ADT. 

Autodesk VIZ Render (VIZr) is an advanced design visualization tool that is integrated into Autodesk Architectural 
Desktop. It is derived from its parent application Autodesk VIZ, but is optimized and streamlined to perform 
rendering and simple animation functions only. You cannot create any objects in VIZ Render other than Cameras 
and Lights. All models are constructed first in Autodesk Architectural Desktop (ADT). These models are then 
transferred to VIZr using an integrated linking mechanism to create spectacular renderings of these creations. 

ADT is required to generate renderings from VIZr. VIZ Render is a feature of Autodesk Architectural Desktop and 
cannot be purchased or used as a separate application. To create a rendering, you must first build a three-
dimensional model in ADT. You then link your model to VIZr, where you can add lighting, cameras, edit, or add 
materials. Finally you generate a rendered image. The results can be simple and diagrammatic, or stunningly 
photorealistic. The results you get out of the software depend highly on what you put into it. Although ADT is 
required, your level of expertise in ADT can vary widely and still yield good results with VIZr. In other words, it is 
not necessary for you to master ADT before embarking on learning VIZ Render. A casual familiarity of the basics 
is sufficient. 3D Rendering is realistically a trinity of modeling, lighting/materials, and rendering. It is naturally 
valuable to know as much as you can about each of these three separate but equally important parts of the 3D 
rendering process, however, mastery of each is not a prerequisite to working with the others. 

The following is a series of Tips and Tricks to help you save time while working and rendering with VIZ Render. 

Modeling and User Interface: 
1. Geometry 

Modeling in VIZ Render is nearly nonexistent. With the exception of applying some modifiers to 2D geometry, all 
modeling is completed in ADT. So, in the spirit of efficiency we need to get creative in order to save time 
modeling detailed objects that are unnecessary when it comes to CD’s. Mainly this will consist of entourage that 
brings life and believability to your scene. 

There are many resources from which you can draw given the fact that VIZ Render is capable of “merging” DRF 
and MAX file types. The merge capability enables you to import files created in Autodesk VIZ or 3dsmax directly 
into your VIR Render scene. This greatly extends your reach to files created in-house, by visualization experts or 
the rendering community abroad. There are many web sites out there where you can access all sorts of models 
such as lampposts, furniture, and cars. These are available either for purchase or for free download. 

Try these sites: 

 HermanMiller.com  
 ScottOnstott.com  
 Kohler.com  
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 Turbosquid.com  
 Mr-cad.com  

 

A larger listing of sites with resources for ADT and VIZ Render users is available at: 
http://www.paulaubin.com/mastering_viz.php scroll down and click the link next to Appendix B. This file will also 
be made available on the AU2004 web site after the conference. 

 

2. Reload Options 
The file link concept is much like an External Reference (XREF) within ADT. All file link updates must be manually 
executed. There are four options to do so. 

 
Figure 1 
Exploring the various combinations of Reload Geometry and Materials 

Reload Geometry and Materials—Use this icon to reload an ADT model in VIZ Render. You can find the same 
function on the File menu named File Link Manager. 

When you reload an ADT model, there are two toggles that control the behavior of the materials imported from the 
ADT model. The first time you execute a file link all materials assigned to the ADT objects will automatically be 
imported and remain assigned in VIZr. In some cases, you will have defined new or edited existing materials in 
VIZ Render. You may also have changed the material assignments of linked objects in the scene. To preserve 
these types of changes upon reload, you can use the two toggle icons next to the Reload Geometry and Materials 
icon (or the equivalent icons in the File Link Manager dialog).  

Use scene material definitions—with this toggle active (push the icon in) this option will maintain in the scene, 
any materials you have edited in VIZ Render in favor of those being reloaded from Architectural Desktop. If this 
toggle is not enabled, the original material definitions from the ADT model will overwrite the ones in your VIZr 
scene. For example let’s say that you edit a brick material to use a different type of brick coursing. When the ADT 
model is reloaded, the ADT version of the material you edited still contains the old coursing. With this option 
enabled, you will maintain your edited coursing in VIZr. With it toggled off, the ADT coursing will re-import and 
replace your edits in VIZr. 

Use scene material assignments (on Reload)—with this toggle active, this option will maintain, in the scene, 
any material assignments that you have made in VIZ Render in favor of those being reloaded from Architectural 
Desktop. For example, let’s say that your ADT model contains a stud wall. In VIZr you assign a brick material to 
this wall. With this option enabled, this wall will remain brick even after the reload. With this option toggled off, it 
would return to being a stud wall. 

Use both Options—You can toggle both of the previous options on at the same time and preserve both material 
edits and assignments as geometry is reloaded. 

Bind (break link to drawing)—The final icon on the File Link toolbar is the Bind icon. This option will 
completely break the link to the ADT model file. This action cannot be undone. This is much like the XREF Bind 
option in ADT. 

The Bind option can be quite handy for harvesting geometry from other VIZ Render scenes that are currently 
linked back to an ADT file. 

Try this: 
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 Open the full_house_complete.drf file found in your Tutorial\VIZ Render\Full_House folder and save it as 
“Living Room Furniture.”  

 File > File Link Manager > Click on Bind and then Proceed with Bind and finally Close the dialog  
 Pan in the Top viewport so you can see the dining room table that you see in the shaded viewport.  
 Make a selection window around them and then open the selection floater 

 

 
Figure 2 
Selection Floater icon 

 In the selection floater, invert the selection and press select.  
 Close the Selection Floater and press the Delete key.  
 You now have a file of just the dining room furniture to save and re-use for another scene. 

 

 
Figure 3 
Harvested Dining Room Furniture 

 

3. Saving Materials for later Use 
Tools and Tool Palettes combined with Content Browser can be quite a powerful team when it comes to saving 
materials for later use. When the time comes, open Content Browser (see Figure 4) and create a new Catalog for 
your materials. Depending on how you want to organize your materials, you may also want to create palettes or 
categories to group your materials. Next, drag your materials to Content Browser. If you choose to keep your 
materials on palettes, you can simply drag that palette into your VIZ Render scene for quick access to many of 
your custom materials. The major benefit is that these materials are linked back to Content Browser so that you 
will always have the latest settings for your materials at hand. 
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Figure 4 
Content Browser Icon 

 

4. Spinners 
Spinners are the up and down arrows that allow adjustment to the values for nearly all settings in VIZ Render. If 
you click and hold down the spinner, it will adjust at an average rate. If you hold down the CTRL key while 
dragging a spinner, it will change the value at a faster rate while holding the ALT key while dragging a spinner will 
change the value at a slower rate. Right clicking while adjusting the spinner will reset the value to what it was set 
at before you began adjusting the value. Right clicking at any other time will reset the spinner to the lowest 
allowable value. 

 

5. Customizable user interface 
Just like its big brother and sister, max and VIZ, VIZ Render’s user interface (UI) is customizable. You can even 
choose which side your command panel is docked. Or simply float it like the palettes (see Figure 5). If you hit the 
Customize option on the context menu seen in Figure 5, you enter the dialog where all keyboard shortcuts, 
colors, and other UI elements can be tweaked to your liking. 

 
Figure 5 
Docking or floating the Command Panel 

 

6. Preferences 
A couple of gems are hidden in Preferences. Sometimes it is hard to see the output of lights that use photometry 
specified in IES files (downloadable from ERCO, e-Lumit, or LouisPoulsen). The Non-scaling object size controls 
the size of many objects such as your daylight, cameras, etc. If you are using Feet and Inches for your units it 
may appear that this is an absolute value, but in fact it is relative to your screen, meaning that if you zoom, it will 
not resize. The second gem here is the setting to Choose Driver. More than likely when you started using VIZ 
Render you chose Software for your display driver. You can change that setting here later if you choose. 
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Figure 6 
Re-sizing Lights and Camera graphics 

 

7. Substitution 
Since our ADT models’ primary function is for the completion of CD’s, we do not want to fill them up with a lot of 
overly detailed models of furniture etc. The Substitution Manager is useful to help us manage this. In ADT you can 
create simple 2D block geometry and then choose to associate that block with an entire VIZ Render, VIZ, or 
3dsmax file (see Figure 7). 

 
 

Figure 7 
Accessing the Substitution Manager 
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8. Transform Type-in 
Right click on the transform icons (see Figure 8) to access the Transform Type-in dialog where you can Move, 
Copy, or Rotate an object exactly as you wish in contrast to the more freeform use of the transform gizmos. For 
example, use the Absolute: section to move an object to a specific location such as 0,0,0. Use the Relative: 
section to move that object relative to its existing location. For example, move the object up 2 feet by typing in 2’ 
in the Y section. It will be set to 0 again after the transform because it is waiting for another input. 

 
Figure 8 
Transform Type-in dialog 

 

9. Default City when dropping a Daylight System 
So, you have finally gotten tired of changing the Daylight settings to match the location where you do most of 
your work. Open the file C:\Documents and Settings\<username>\Local Settings\Application Data\Autodesk\ADT 
2005\enu\VIZRender\PLugCFG\sitename.txt. Locate your city in the list and add a "*" before the first letter. Also, 
unless you are choosing San Francisco, then you will need to remove that one. For example: 

+303289 +0816617 *Jacksonville FL 

If your city is not listed try the following to find your Latitude (first) and Longitude (second). Latitude and 
Longitude will be in decimal degrees with no period. 

http://www.getty.edu/research/conducting_research/vocabularies/tgn/index.html 

 

10. Test render in wireframe 
Rendering > Make Preview will lead to a dialog where you can create a slew of various test renders for your 
animation. Choose from Rendering Level to set it to wireframe. This list mimics the settings for the viewports. 

 

 

Figure 9 
Make Preview dialog 
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11. Lost your transform gizmos? 
There’s no button for it. Type “X” on the keyboard to toggle ON and OFF. (Please note that keyboard shortcuts in 
VIZ Render do not use the ENTER key as they do in ADT, so don’t press ENTER, just type the shortcut). If this 
does not work, check what Hotkey is assigned to the Transform Gizmo Toggle via Customize > Customize UI > 
Keyboard tab. 

 
Figure 10 
Transform Gizmo ON vs OFF 

 

12. Quickly selecting objects 
Let’s say you would like to create a sun study. This model already has materials you would like to keep. The first 
thing you will want to do is work on a copy of this file. To accomplish this, link that model to VIZ Render and 
choose File > Save Copy As and give the file a new name. Doing this will retain the original VIZ Render file with 
all the materials still applied and gives you a copy to work on. Now that you have a working file, you now want to 
select everything in the scene that is NOT glass. To accomplish this, press the Selection Floater icon (see Figure 
2). In the edit box at the top of the dialog, type in *glass and watch what is highlighted in the list. What we have 
just done is highlighted all the components in the scene that have the name glass. Press the Select button at the 
bottom right. Now reverse that selection by pressing the Invert button near the bottom of the dialog and then 
press Select to lock in the selection set. If you would like to save this selection set for later use, type in a name in 
the Named Selection Set Status Bar (see Figure 11). Now that those objects are in your current selection set, you 
can then apply your study model material to them quickly. 

 
Figure 11 
Transform Gizmo ON vs OFF 

 

Rendering: 
13. Rendering Properties 

Radiosity meshing does not need to be as tight and defined on larger surfaces. For example, if you have a scene 
with a building sitting on a relatively large site. The site is necessary for context and the desired view but its 
radiosity perfection is not critical. Select the site geometry, right click and choose Rendering Properties. In that 
dialog uncheck the Use Global Subdivision Settings option and set the Meshing size to a much larger value than 
your Global setting. By “much larger” try 5 to 10 times the size of your global setting. Further more, if you have 
geometry in your scene that will not be seen, such as shadow-casting objects, you may want to simply uncheck 
the Subdivide option for those objects. While you’re at it, you should turn off the Exclude from Regathering 
option as well. This will only make a difference if you use Regathering in your final rendering. For more 
information refer to Help > User Reference > Contents tab > Radiosity > Radiosity Panel Rollouts > Rendering 
Parameters Rollout. 
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Figure 12 
Global Meshing override 

 

An interactive list of render settings is available at: http://www.paulaubin.com/mastering_viz.php scroll down and 
click the link next to Appendix C. This file will also be made available on the AU2004 web site after the 
conference.  

 

14. Ray Bounces 
The Ray Bounce setting is one of those little settings that elude most new visualization artist that could save a lot 
of rendering time. By default it is set to 9. That means between reflective materials, the light is bounced back and 
forth 9 times.  A setting of 3 is typically quite sufficient in most cases with slightly better results with an 
exponential increase in rendering time as the setting is increased. For example, one test we performed showed a 
33% increase in rendering time in a small scene with four windows (transparent and highly reflective materials) 
between a setting of 3 and 9. In that same scene we changed the walls to use a glass material and re-rendered 
with both settings. The difference between rendering time was increased by nearly 600%. The point here is that 
as your scene matures with highly reflective materials, this setting needs to be monitored for efficiency. 

 
Figure 13 
Render Options rollout 

 

15. Render Comparison 
There are two tools that will help you compare your test renderings. The first is the Clone icon on the Render 
Frame window. Press the Clone icon to make a duplicate of this dialog before running the rendering again after 
making changes. 
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Figure 14 
Clone Rendering Frame Window 

 

The second is the Ram Player (Rendering > Ram Player). Ram Player allows you to load up to two images for 
side-by-side comparison. Open the first image on the left and the second on the right. The arrows to the left and 
right are controls that allow you to scrub up and down or left and right depending on the status of the split 
screen toggle (see Figure 15). 

 
Figure 15 
Ram Player 

 

 

 

You can reach James D. Smell or Paul F. Aubin at: MasterVIZr@paulaubin.com. Please visit: www.paulaubin.com 
for information on books and service offerings.  

 


